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Welcome to HIARCS Chess Explorer Pro

HIARCS Chess Explorer Pro is a new highly advanced chess database, analysis and
playing program for PC Windows and Apple Mac computers. It offers a very powerful
user interface with the strongest ever HIARCS chess engine and world class chess
database features. This unique combination offers easy to use features managing
chess databases, preparation, analysis, play and training for players of all abilities
from beginner to Grandmasters and beyond.

There are a great many unique features in HIARCS Chess Explorer Pro and we have
written this manual so you can get the most out of our software. This manual is a
live document and as such will be updated on a regular basis.

This documentation is for the HIARCS Chess Explorer Pro product. Current version 1.0.0.0

Credits and acknowledgements

Other software and resources used by HCE

-   Qt 5.15.2 or Qt 6.2.1 - open-source crossplatform applications framework
-   uncbv - CBV archive extractor
-   FontAwesome - free web icon set
-   Chess Pirat - figurine font by Klaus Wolf
-   Board textures based on CC0Textures
-   Alpha, Leipzig, Merida & USCF chess piece images by Eric de Mund and
    Bruno Rizzuti (based on fonts by Eric Bentzen and Armando Marroquin)
-   Modern & Russian chess piece images by Bryan Whitby
-   Hiarcs chess piece images by Steven Uniacke
-   Fun chess piece images based on design by Ole Christensen
-   Annotated games from CHESS magazine used with kind permission of
    www.chess.co.uk

Translations:
French: Yves Catineau, A. Zanchetta and Jonathan Naud
German: Christian Goralski, Kai Freitag, Astrid Erver and Jeremy Bernstein
Italian: Bruno Rizzuti
Polish: Michał Rudolf

www.hiarcs.com/chess-explorer-pro.html
https://www.hiarcs.com/chess-explorer-pro.html
https://www.hiarcs.com/pc-chess-explorer-pro.html
https://www.hiarcs.com/mac-chess-explorer-pro.html
https://qt.io
https://qt.io
https://github.com/antoyo/uncbv
https://fontawesome.com
https://cc0textures.com
https://www.chess.co.uk
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Portuguese: C. R. Zamana
Spanish: Amador Cuesta

Testing and feedback by Eric Hallsworth, Jeremy Ward, Harvey Williamson and a very
large number of beta testers, not named for privacy reasons.

Thank you to all those people who helped make HIARCS Chess Explorer a better
product.

We also thank Eugene Nalimov and Andrew Kadatch for their kind permission to use
their access code (copyright (c) Eugene Nalimov) and decompression code (copyright
(c) Andrew Kadatch) for Nalimov tablebases in HIARCS chess engines. We would also
like to thank Ronald de Man for his Syzygy tablebases.

Included items

HIARCS Chess Explorer Pro includes the following main components:
· HIARCS Chess Explorer Graphical User Interface (GUI) - this is the presentation

you see and interact with. 
· HIARCS chess engine(s) - this is the electronic chess brain which analyses and

plays chess.
· HIARCS Chess Explorer supports engines which comply with the Universal Chess

Interface specification. 
· The HIARCS chess engines included in the package are UCI compatible:

o Deep HIARCS 15.0 (available with the Deep and Premium HIARCS Chess
Explorer Pro products)

o HIARCS 15.0
· Opening books - these are collections of positions, moves and statistics which help

show you the chess openings, play chess openings and classify and name openings
played. These electronic books are used by HIARCS Chess Explorer to present the
information within them. They cannot be read by other software.

· Chess databases - these are collections of players, games and commented games
which you can load, view, modify, play through etc, etc. The following databases
are included:

o MasterBase - this is a database of games between the world's strongest
chess players, generally of last 15 years.

o AnnotatedBase - this is a database of games annotated by strong chess
players including International Masters and Grandmasters.

o FischerSpassky - this database contains all the games played between these
great rival players. 

o KasparovKarpov - this database contains all the games played between
these great rival players. 

o Tactics - this database contains tactical puzzles. 

Please note you can add other UCI chess engines including third party UCI chess
engines into HIARCS Chess Explorer Pro. You can also use HIARCS chess engines in
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other chess GUIs which support UCI engines. We strongly recommend activation of
our engines in HIARCS Chess Explorer as we have found many other chess GUIs are
not 100% compatible with the UCI specification for activating/registering engines.

Premium HIARCS customers will receive the latest HIARCS experimental
improvements, many of these will be aimed scaling on many core systems.

By default Deep HIARCS 15.0 uses half the physical cores of the system. We choose
this default so that most customers are able to run Deep HIARCS 15 in multiple
database tabs without affecting overall system performance. You can change the
number of threads used in the Analysis Explorer toolbar. That allows you to set
anything from 1 to a maximum of the number of logical cores on your machine. If you
want to change the default threads used for Deep HIARCS 15.0 in all database tabs
please go to the Preferences->Engines dialog and select Deep HIARCS 15.0 and set the
threads to your choice.

Please note HIARCS Chess Explorer Pro also has a load alert which is a red square
which appears in the bottom right hand corner of the window, if you see that you can
move the mouse pointer over the red square to get info on the system usage of the
engines running.

Installation on Mac OS
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When you purchase HIARCS Chess Explorer Pro you will be sent an email with a
download link where you can download the HIARCS Chess Explorer Pro installer.
Download the installer and run it to install the software.

After downloading, run the installer by double clicking it...

Click continue
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Please read the End-User License Agreement, agreement is required to continue to
install and use the software
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We strongly recommend you install the software in the default location
of /Applications. Click Install to proceed



HIARCS Chess Explorer Pro

10 / 128

Enter your password to allow the installation to proceed.
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Installation is now complete and you will find HIARCS Chess Explorer Pro installed in
your /Applications folder. We recommend you also drag it to your Dock bar for easy
access in future.

The Databases and other files are installed in the Documents/HIARCS Chess folder.

Installation folders

When HIARCS Chess Explorer Pro is installed it creates a number of folders for the
Application itself, chess engines and data files including databases. This section
explains where the files are installed.

Application Folder
The application and engines are installed in /Applications in the HIARCS Chess
Explorer Pro.app
 

Data Folders
The HIARCS Chess Explorer Pro installs data files in your Documents folder under
Documents/HIARCS Chess

 The following sub folders are installed:
· Books - this folder contains the books HIARCS uses, book subscribers can add books

issued as part of the Book Subscription to this folder and HIARCS 14 engines will
automatically use the latest book

· Databases - this folder contains the packaged databases which are included with
HIARCS Chess Explorer

· EngineData - this folder contains the engine data folders
· Engines - HIARCS engines are installed here
· Logs - log files can be stored here

Installation on PC Windows
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When you purchase HIARCS Chess Explorer Pro you will be sent an email with a
download link where you can download the HIARCS Chess Explorer Pro installer.
Download the installer and run it to install the software.

To install you will need to allow the installer to make changes by clicking yes to this
dialog...

Before you can install HIARCS Chess Explorer Pro you will need to accept the terms of
the End User License Agreement
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In the next dialog you will have the choice to create a desktop icon which will
appear on your desktop and make launching HIARCS Chess Explorer Pro easier. You
will then be given a dialog which simply asks you to click the Install button to install
HIARCS Chess Explorer Pro. Click this button and installation will begin, you will see
the installation progress.
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Installation folders

When HIARCS Chess Explorer Pro is installed it creates a number of folders for the
Application itself, chess engines and data files including databases. This section
explains where the files are installed.

Application Folder
The application and engines are installed in the \Program Files (x86)\HIARCS
Chess\HIARCS Chess Explorer Pro folder.
 

Data Folders
The HIARCS Chess Explorer Pro installs data files in your Documents folder under
Documents/HIARCS Chess

 The following sub folders are installed:
· Books - this folder contains the books HIARCS uses, book subscribers can add books

issued as part of the Book Subscription to this folder and HIARCS 14 engines will
automatically use the latest book

· Databases - this folder contains the packaged databases which are included with
HIARCS Chess Explorer

· EngineData - this folder contains the engine data folders
· Engines - HIARCS engines are installed here
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· Logs - log files can be stored here

Activation
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When HIARCS Chess Explorer first runs you will be asked to enter your license key.
Your personal license key was emailed to you immediately after you purchased
HIARCS Chess Explorer. Enter the license name and code into the Registration dialog
to activate the product:

You can copy (Ctrl+C on Windows, Cmd+C on Mac) and paste (Ctrl+V) the license
name and code into each field. Once you have entered the license name and code,
click the Register button to activate HIARCS Chess Explorer Pro.

Alternatively you can copy the license key from the email and click Paste from email
and HCE Pro will parse the email and enter the details. 

Activation of HIARCS Chess Explorer Pro requires access to our servers so please
ensure your internet connection is working. 

After a short delay you will then get confirmation that HIARCS Chess Explorer Pro has
been successfully registered and activated. You will not need to activate on the same
machine again unless you deactivate the license from the About dialog because you
might want to give your computer away or sell it.

Overview
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The HCE Pro windows consists of a number of explorer views from the top down:
· Window title: Current database name - HIARCS Chess Explorer Pro
· Menus at the top of the window
· Toolbar icons which give shortcuts for accessing common functions
· Tabs - one per database
· Game board showing the current position of the game being examined
· Game notation is shown to the top right of the board. It has the game header

showing who played the game and the game move notation, this can contain
symbols and comments

· A Tree Explorer view of the current database showing the moves played from the
current position by all games in the database and their statistics

· Book explorer showing the Local book with the recommended moves and statistics
from the current position. You can select various books.

· The Analysis Explorer view shows the engine analysis of the current position
· Evaluation Explorer view shows the game evaluations throughout the current

game and can be used for navigation
· Finally at the bottom of the window is the Game Explorer view which lists the

games in the current database based on the current filter.

Concepts
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Database tabs

Each database in HIARCS Chess Explorer Pro is opened within a tab.

This means you can have multiple databases open simultaneously without having to
manage lots of windows.

You can move tabs around by simply selecting a tab and dragging and dropping the
tab into a new placement, for example you can drag the MasterBase database tab
and place it between the Kasparov-Karpov and Tactics database tabs.

To work on a database simply click on the tab and the database and its display panes
will be accessible.

As you will find out HIARCS Chess Explorer makes it simple to have multiple
databases open at the same time and this ease and flexibility allows a different
approach to analysing and working with databases compared to single
game/database programs.

You can close a database at any time by clicking X next to the name of the database
tab or by selecting the File->Close menu item which will close the database in the
current selected active tab.

We recommend you use the new HCE file format as once a database is in our new
format all its operations are near instant.

Please note when opening very large PGN databases it can take some time to load all
the games and build the required views of the data. However once the database is
loaded even complex position searches are performed almost instantly. Equally when
you exit a database tab containing a very large PGN database it takes time to save if
changes have been made to that database. For this reason when large PGN databases
are opened you will be offered the option to convert the database into HCE format.

Database and filters

In HIARCS Chess Explorer Pro there are up to 4 groups of games which some
operations can be applied to:

· Database - all the games in the database
· Filter - only the games in the current search filter
· Selection - this is a selection of games ticked in the Game Explorer game list.
· Current game

Some functions operate on all four groups, while other's handle only the current
game or some combination of game and filter.

When you first open a database the current filter is set to the entire database. When
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you search for games the resulting set of games becomes the new filter. In numeric
terms the size of the filter is shown in the title bar of the Game Explorer view. 

This shows you that the Game Explorer is showing 58 out of 347,333 games. The
current filter contains those 58 games.

There many ways to search for games that set the games filter you can read more
about these in the Finding games section.

Although the filter is normally set as a result of a search you can add to the existing
filter using the Header search.

Elo ratings

Chess players are given a chess rating to gauge how strong they are at chess. The
standard rating system used in chess is called Elo ratings named after Arpad Elo. A
related system is used in tennis, football and many other sports.

Elo ratings are based on the results of games and ratings of opponents played. The
Elo rating system ranges from 1000 Elo (a complete novice) to 2800 Elo and beyond
for the strongest players of all time.

Were a player A to score two points for every one point of player B, then player A
would be expected from this performance to have an Elo rating about 120 Elo points
more than player B. As you can see there is a great difference in chess strength as
you go up the ratings.

The ratings can be split into the following broad classes:

Class of Player Rating Range

World Champion 2800+ Elo

World Championship contender 2700-2800 Elo

Super Grandmaster 2600-2700 Elo

Grandmaster 2500-2600 Elo

International Master 2400-2500 Elo

Master 2200-2400 Elo

Expert 2000-2200 Elo

Class A - Strong club player 1800-2000 Elo
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Class B - Club team player 1600-1800 Elo

Class C - Club player 1400-1600 Elo

Class D - Hobby player 1200-1400 Elo

Class E - Beginner/Novice 1000-1200 Elo

Class F - Complete beginner 750-1000 Elo

HIARCS Chess Explorer Pro allows you to set any of these strengths in the play game
dialog.

What's new
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Version 1.0  3rd January 2022
Initial release of HIARCS Chess Explorer Pro

Key features include:

· Advanced Database Support
o HCE database format offers huge databases only limited by memory - 1GB

per 8 million games
o Fast searching for players, openings, events, material, pawn structure and

positions.
o Comprehensive game database support (PGN, HCE, reads Chessbase CBH,

CBV and EPD)
o Extensive game notation with variations, comments, symbols, diagrams and

named openings
o Export and publish your work, games and preparation to PGN, PDF, EPUB e-

book and HTML
o Reference databases, manage databases, duplicate search and clean up,

watch live games
· HIARCS 15 chess engine – more than 200 Elo stronger

o Full range of realistic set Elo levels with human like playing style, have your
strength matched

o Very strong analysis & play, more than 200 Elo stronger than HIARCS 14
WCSC engine

o Supports up to 32† threads/cores, and any UCI Chess User Interface
(Chessbase/Fritz)

· Player Explorer
o View reports on players, their games, performances and favourite openings

and statistics
o Build tree of games and openings of players instantly into a player report

with a single click
o Automated repertoire summaries for databases and players. Merge

misspelled players
· Game, Opening and Tree Explorers

o Revolutionary multi-source chess trees with moves, statistics from games
and advice

o Build an opening repertoire tree instantly from database games to learn and
prepare openings

o Access huge online opening books, view multiple books & Chessbase CTG
books simultaneously

· Analysis and Evaluation Explorers
o Analyse positions and games with multiple engines simultaneously with load

management
o Multiple lines of analysis with stats, move selection and integrate analysis

with game notation
o Check games for blunders, inaccuracies and improvements with post game
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analysis
· Custom Playing modes

o Play against the computer with human-like play and full range of handicap
Elo levels

o Choose rating, time controls, start positions and even chess openings for
practice

o Train with the guess the move feature, learn and improve your tactical and
positional play

o Coach points out mistakes, shows move quality and hints. Rates your play in
Elo points

o Engine matches – set up and watch them play or have them play out test or
analysis positions

· Packaged Databases
o Top quality database with 300,000+ Master games, IM/GM annotated games,

tactical exercises
o Online access to up over to 1,000 GB of endgame tablebases and opening

book databases
o Local book with latest GM Theory and access to much larger online books

Getting Started

Once installed you can run HIARCS Chess Explorer Pro from:

· On PC Windows from the Start menu and also from the desktop shortcut. We recommend you pin
HIARCS Chess Explorer to the task bar for quick access.

· On Mac OS from the /Applications folder. We recommend you copy HIARCS Chess Explorer Pro to
the Dock bar for quick access to the app in the future.

System requirements
HIARCS Chess Explorer Pro for PC: Windows 7, 8, 10 or 11 64 bit (all editions) 

HIARCS Chess Explorer Pro for Mac: macOS 10.14 Mojave or later, including Catalina, BigSur and
Monterey

Please note a license to use HIARCS Chess Explorer Pro on one platform does not give access on the
other platforms. For example a PC Windows license does not provide use on Mac OS. However, we
offer very good discounted rates for those who want to purchase the other platform product. Please
email hiarcs@hiarcs.com for details.

Setting a language

HIARCS Chess Explorer will use the default language of your operating system. If you
want to use a different language you can choose the language in the Preferences-
>Advanced tab. There you can set the language to English (UK), English (US), French,
German, Italian, Polish, Portuguese and Spanish.

Finding games

There are many ways in HIARCS Chess Explorer Pro to find games in an open
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database:

· Select the Search header  toolbar icon or Database->Search header menu

item to access the Search header dialog to search the database for games
matching game header criteria, e.g. players, event, rating, dates etc, etc. 

· Open the Game Explorer view and use the Quick search field for fast searching.
· Open the Tree Explorer and use the Tree ->Set filter option to show all games

matching the current position
· Open the Player Explorer and find games, wins, draw, losses or openings of a

particular player
· Use the Database->Find position menu item to open the Find position dialog to find

the games containing a position you are interested in.

When you first open a database the current filter is set to the whole database. When
you search for games the result is normally a subset of the games and this subset is
the current filter.

Every time you search for games it creates a new filter of games. Using the Header
search it is possible to add to the current filter of games.

Getting help
This manual is the best first stop for help. In the future will be posting videos on the product which
you will be able to access from our website www.hiarcs.com

User Interface

Main window

https://www.hiarcs.com
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The HCE Pro windows consists of a number of explorer views from the top down:
· Window title: Current database name - HIARCS Chess Explorer Pro
· Menus at the top of the window
· Toolbar icons which give shortcuts for accessing common functions
· Tabs - one per database
· Game board showing the current position of the game being examined
· Game notation is shown to the top right of the board. It has the game header

showing who played the game and the game move notation, this can contain
symbols and comments

· A Tree Explorer view of the current database showing the moves played from the
current position by all games in the database and their statistics

· Book explorer showing the Local book with the recommended moves and statistics
from the current position. You can select various books.

· The Analysis Explorer view shows the engine analysis of the current position
· Evaluation Explorer view shows the game evaluations throughout the current

game and can be used for navigation
· Finally at the bottom of the window is the Game Explorer view which lists the

games in the current database based on the current filter.

Short cut toolbar icons
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In a normal database tab you will see the following shortcut icons in the toolbar:

In play game mode the tool bar has the following shortcut icons in the toolbar:

The toolbar icons are made up of the following icon sets, click the set to find out
more about them.

· Database icons
· Game icons
· View Icons
· Play icons

Database icons

        Show the Preferences dialog

These database shortcut icons give you quick access to common operations on a
database:

        Open a database in a new tab

        Show Game Explorer for current database

        Show Player Explorer for current database

        Search database for games

        Load previous game in database

        Load next game in database
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        Load a recent game previously loaded in this database: 

When you have a remote or live PGN file loaded you will also see the following icon:

        Reload the remote live PGN file and merge with existing games.

Game icons

These game shortcut icons give you quick access to common operations on the game:

        Create a new game ready for game entry

        Set up position to modify the existing position or set up a new position

        Edit game header, this gives you the ability to set or modify the header

information for the game

        Rotate the board 180 degrees effectively changing the colour of the

player playing up the board

        Go to the start of the game

        Takeback last move played in the game
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        Make the next move in the game

        Go to the end of the game

        Replay moves in the game from the current position onwards

        Pause/stop the replay of the game. This is only seen during a game

replay.

View icons

These shortcut icons give you quick access to common operations affecting the
presentation or mode of presentation:

        Play a game against the computer

        Show the Analysis Explorer view

        Show the Tree Explorer view

        Show the Book Explorer view

Play icons

These play game shortcut toolbar icons give you quick access to common operations
while playing a game against the computer:
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        Pause the game in progress. Stop the clocks (if present) so you can take a

break. Click again to resume.

        Force the computer to move immediately when the engine is thinking.

        Take back your last move including the computer response.

        Replay your last move. If you had previously performed a takeback, this

icon will replay both your move and the computer response. If no takeback was
performed this icon will replay the computer's last move played.

        Change sides with the computer. You will be asked to confirm this, as you

can imagine you should not do this in a rated game if you want an accurate chess
rating.

        Set up position enabling you to modify the current position and even set

up a new one.

        Toggle the coach on or off. The coach is on when this icon is highlighted.

The coach provides move advice and warnings when you make mistakes or miss good
moves.

        Ask the computer for a hint move. This will be graphical demonstrated

on the board.

Entering and annotating games

Within any database tab you can enter, copy or paste games. To start a new game
choose the Game->New menu item and the Game Notation will be cleared ready for
entry of a new game.

You can enter and adjust moves,variations and add/edit comments, move symbols,
evaluation symbols or other symbols at any time using the move context menu.

You can highlight squares and draw arrows on the board to illustrate points and
explain ideas.
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The following table explains how you can achieve the effects shown in the board
above. Please note making the same gesture on a square removes the highlight.
PC/Mac keys: Ctrl=Control key (PC & Mac), Alt= Alt key (PC), Cmd=Command key
(Mac), Option=Option key (Mac)

Effect required Key stroke Example

Highlight square in
green

Press Alt (PC) / Ctrl (Mac) key
while clicking on square
OR right mouse click on
square

Press Alt/Ctrl key and click on
the f2 square to highlight it in
green

Draw arrow from
source to destination
square in green

Press Alt (PC) / Ctrl (Mac) key
while clicking down on
source square, release the
mouse on the destination
square
OR hold right mouse click
with drag/release

Press Alt/Ctrl key and click on
the f1 square and release on
the c4 square to draw a green
arrow from f1 to c4.

Highlight square in
yellow

Press Ctrl with the Alt (PC) /
Cmd (Mac) key while clicking
on square
OR Press Ctrl (PC) / Cmd

Press Ctrl with Alt/Cmd keys
and click on the g2 square to
highlight it in yellow
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(Mac) and click right mouse
on square

Draw arrow from
source to destination
square in yellow

Press Ctrl with Alt (PC) /
Cmd (Mac) keys while
clicking down on a source
square, release the mouse on
the destination square
OR Press Ctrl (PC) / Cmd
(Mac) and hold right mouse
click with drag/release

Press Ctrl with Alt/Cmd keys
and click on the f1 square and
release on the c4 square to
draw a green arrow from f1 to
c4.

Highlight square in
red

Press Shift with Alt (PC) /
Option (Mac) key while
clicking on square
OR Press Shift and right
mouse click on square

Press Shift with Alt/Option keys
and click on the h2 square to
highlight it in red

Draw arrow from
source to destination
square in red

Press Shift with Alt (PC) /
Option (Mac) key while
clicking down on a source
square, release the mouse on
the destination square
OR Press Shift and hold right
mouse click with
drag/release

Press Shift with Alt/Option keys
and click on the g8 square and
release on the f6 square to
draw a red arrow from g8 to f6.

Menus
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HIARCS Chess Explorer Pro uses menus to access much of its functionality. Many of
the menus have shortcut key strokes that can be used to access the function from the
keyboard. There are also many shortcut icons which give quick one click access to
commonly used functionality. You will see the shortcuts given on the menu items.

In this section we look at the menus available and describe the purpose of each
menu item.

File menu

https://www.hiarcs.com/hce-manual/pc/Shortcuttoolbaricons.html
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The File menu allows you to manipulate files. Please note the shortcut keystroke for
common operations are also defined on the menu, you can use the keyboard shortcut
to invoke the associated function directly from the keyboard. You can also see
shortcut icons for some menu items on the menu as a guide that there is a shortcut
toolbar icon for the option.

New...
Create a new HCE or PGN database, you will be shown a New database dialog to set
the new database name. The new  database will then be created and opened in a
new database tab.

Open...
Open an existing or new database, you will be shown a Databases dialog which shows
all the previous databases you have used and allows you to open other databases.
Choose the database to open and it will be opened in a new database tab.

Open work database
Open the WorkBase database in a database tab. Normally the WorkBase is open by
default, it has special properties which means it autosaves all your work and is a
useful tool for general chess work.

Open played games
Open the PlayedGames database in a database tab. The PlayedGames database
contains the games you play against the computer, these are auto-saved.

Open engine games
Open the EngineGames database in a database tab. The EngineGames database
contains the games played in engine matches, these are auto-saved.

Open URL...
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Open a URL of an online database. You will be shown an Open URL dialog which
enable you to enter the http address of a PGN to download and keep live with
updates.

Reload
The menu item allows you to reload a live PGN database PGN. This is only active if
you have a live PGN open.

Import..
This menu item allows you to import a database into the current database tab. It
opens an Import database dialog to allow you to do this. Please note when you
import games they will be added to your existing current database which is open.
This operation cannot be easily undone so please use caution when importing games
into your important databases.

Export...
This menu item allows you to export a game, filter of games or entire database into
various formats for sharing. It opens an Export database dialog to allow you to do
this. The games and comments are exported accordingly. Please note the game are
exported in the sort order of the Game Explorer game list, for example if you sort
the database by Date, then Export the database HCE-Pro will export the games in
Date order.

Print >

This menu item allows you to print a game or filter/database of games. Be careful
when printing a collection o games as it can require a lot of paper to print.

Close tab
This menu item allows you to close the current tab.

Quit
This menu item allows you to Quit HIARCS Chess Explorer Pro. Please note on Mac OS
the Quit menu item is on the HIARCS Chess Explorer Pro menu.

Edit menu
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The Edit menu enables you to edit variation aspects of the current game notation
and database tab.
 

Set up position...
This menu item enables you to set up a new position. It opens the Setup position
dialog where you can edit the current position or set up a different position of
your choice.

Copy >

The Copy menu item allow you to choose to copy to the clipboard:
o Copy the current position shown on the board (copied in FEN format)
o Copy the previous moves in the current game from the current position (in

PGN format)
o Copy a board image of the current position
o Copy the current game shown on the board (in PGN format)

Paste >

The Paste menu item allows you to choose how to paste a game from the
clipboard:
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o Paste game from clipboard onto current notation
o Merge game from the clipboard with the current game

Undo
This option allows you to undo the last operation you performed in this tab on the
current game. This is very useful to reverse mistakes made in Game Notation.
There is no limit to the number of undo operations you can perform since the
game was loaded.

Redo
This option allows you to redo the last operation which was undone by the Undo
command above. There is no limit on the number of Redo commands performed.

Preferences
The menu item opens the Preferences dialog where you can configure the HIARCS
Chess Explorer Pro settings.

Insert >
This allows you to insert various items into the game notation:

This submenu item allows you to insert into the game notation in a number of
ways using the nested menu items:

o Comment...  - this allows you to insert a text comment at the current move
in the game notation. It will bring up an Edit comment dialog. You can also
add diagram in the Edit comment dialog.

o Preceding comment....  - this allows you to insert a text comment before the
current move of the game. It will bring up an Edit comment dialog.

o Best move - this option will insert the best move as suggested by the current
analysing engine (if one is running) and change the position to after that
move was played and the engine will begin analysing this new position.
Depending on the context of the move to the game notation the following
action is performed:
§ If the move is at the end of the current variation, the move is added to

the game notation.
§ If the move is new and different to that played in the game notation, a

new variation will be started in the game notation with the move
inserted.

§ If the move is the next move in the game notation no new move is
inserted but the position changes to that after the move was played.

§ Please note if you want to insert the whole line currently being analysed
by the current engine simply click on the score/depth text value and
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the whole line will be added as a variation with the evaluation and
depth. In this case the engine will continue to analyse the current
position.

o Null move - this menu item makes a null move in the current position. A null
move is basically making no move therefore giving up the right to move, the
opposite side will then be next to play. A null move is illegal in chess play but
is very useful in analysis, for example you may play a null move in a
variation to illustrate what would happen if the side to play does nothing,
thereby showing possible threats of the opponent. Please note a null move
can also be played on the chess board simply by moving the king of the side
to play onto the opponents king. Null move now has a keyboard short cut of
Ctrl+0.

Please note there are many other context specific items like move, evaluation
and other symbols which can be inserted by right clicking your mouse on a
particular move in the Game notation.

Remove >
This allows you to remove various items from the game notation:

This submenu item allows you to remove from the game notation many different
aspects using the submenu items:

Current symbol - this option removes the current symbol in game notation at
move cursor position
Current variation - this option allows you to remove the current variation shown
in the game notation. It has no effect on the main line of the game, it only
affects variations.
    Remove current variation - this will delete the current variation, for example::
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       choosing remove variation on the 6...e5 variation will remove it:

       

Current highlight - this option removes the current highlight at the move cursor
position
Last move - remove the last move at the current move cursor position
All previous moves - remove all previous moves from current move cursor
position
    this will remove all the previous moves, for example:

       

       choosing remove variation on the move 2...d6 will remove the previous
moves:

      

All next moves - remove all the next moves from the current move cursor
position
    this will remove the following moves/variations:

       

       choosing remove next on the move 7.f3 will remove the move following it:

       

All variations - this option will remove all variations from the game notation
All comments - this option will remove all the comments from the game notation
All symbols - this option will remove all move and evaluation symbols from the
game notation
Everything except main line - this option will remove all comments, variations
and symbols from the game leaving just the main line of the game

Variations > 
Allows you to manipulate variations in the game notation:
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Promote the current variation
Promote  - this is used to promote a variation up one level closer to becoming
the main line of the game. When promoting a variation you are in effect
demoting any variation it replaces. Please see this example:

A main-line and variation:

Promoting the 6...e5 variation has this effect, 6...e5 line is promoted, 6...e6 line
is demoted:

    

Promote to main line - this is used to make a variation become the primary
variation, that is the top variation. When you choose Make primary variation on a
variation like 6...Ng4 in the example below:

       

       It produces makes the 6...Ng4 variation the top variation as follows:

       

Move up - this enable you to move a variation up one level in the notation
Move down - this enable you to move a variation down one level in the notation
Reorder... - this enables you to reorder the variations in the Reorder variations
dialog:
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Set move symbol >
Set the move symbol at the current move cursor position

Set evaluation symbol >
Set the evaluation symbol at the current move cursor position

Add other symbol >
Add other symbols at the current move cursor position
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Toggle Diagram
Add or remove (toggle) a diagram at the current move cursor position in the
game notation.

View menu
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Analysis Explorer >
The Analysis Explorer menu item allow you to directly select an engine to analyse
with:

You can also add or remove lines of analysis of the currently analysing chess engine.
When the engine is selected an Analysis Explorer view opens where the engine
analysis can be displayed.

Game Explorer
The Game Explorer menu item allows you to open or close the Game Explorer view.

Book Explorer
The Book Explorer menu item allows you to open or close the Book Explorer view.

Tree Explorer
The Tree Explorer menu item allows you to open or close the Tree Explorer view.
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Evaluation Explorer
The Evaluation Explorer menu item allows you to open or close the Evaluation
Explorer chart view.

Player Explorer
The Player Explorer menu item allows you to open the Player Explorer dialog.

Tournament table
The Tournament table menu item opens a Tournament table dialog for the current
game.

Guess the move
The Guess the move menu item switches on the Guess the move feature for the
current game. 

Flip board
The Flip board menu item will rotate the game board 180 degrees so you can view
the game board from the other colours perspective.

Show threat
The Show threat menu item instructs HCE-Pro to show you the current threat in the
position visually on the board. It shows the threat for the side not to move.

Next tab
The Next tab menu item will give focus to the next tab in HCE-Pro.

Previous tab
The Previous tab menu item will give focus to the previous tab in HCE-Pro.

Alway show tab bar
This menu items shows tab title for one tab.

Show toolbar
The Show toolbar menu item toggle the display of the toolbar icons.

Layout >
The Layout menu item allows you to select between saving the current window
layout as default or restoring the previously saved default.

Full screen mode
The Full screen mode makes the HIARCS Chess Explorer window enter Full screen
mode.
Mac OS: Please note to exit Full screen mode on macOS move the mouse to the top
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left corner and click the green window button
Windows: Press the F11 key to exit and enter the Full screen mode.

Game menu
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Select >
This menu item enables you to select a particular Game:

o Load the first game in the current database
o Load the next game in the current database
o Load the previous game in the current database
o Load the last game in the current database
o Load a random game in the current database
o Load (Back) the previous game in the current database you have viewed

before
o Load (Forward) the next game in the current database you have viewed

before
o Choose a particular game number to load

Analyse Game...
The Analyse Game menu item opens the Analyse games dialog so you can analyse the
current game or all the games in the current filter or database.
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New

This menu item starts a new game in this database tab. If the existing game in the
game notation has been changed and not saved you will be asked if you wish to save
it before starting the new game. Please note this is starting a new game to enter (not
to play, you can play games via the Play menu)

Edit header...
This menu item opens the Edit header dialog so you can view or edit the header
information for the game.

Save
This menu item saves the current game in the current database replacing the
existing game if it was already in the database.

Save as new game
This menu item saves the current game in the current database making a new game
entry for it in the database. Please note this option should be used with caution since
creating another instance of the same game in the same database will reduce the
value of the database statistics used in the Tree Explorer. It is also not good practice
to have multiple copies of the same game in a database, if you want the duplicate
game for a special purpose, consider whether you should copy the game into a
different database for that purpose.

E-mail current game
This menu item opens your default E-mail program with the current game so you can
email it to someone else.

Play menu
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New game...
This menu item allows you to start a new game to play against the computer, it
opens the Play game dialog so you can set the conditions for the game.

From current position...
This menu item allows you to play a new game against the computer from the
current position.

New engine match...
This new menu item allows you to start a new engine match where chess engines will
play each other. This opens the Engine match dialog. This feature was added in v1.7.

Adjudicate >
This menu item is only active in engine matches and allows you to manually
adjudicate a game in the engine match as:

Takeback
This menu item allows you to takeback a move during the game. It takes back both
the computers response and your last move.

Replay move
This menu item allows you to replay the next move in the game. Clearly this can only
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happen after a takeback so there is a next move.  It replays both your next move and
the computers response.

Switch sides
This menu item allows you to change sides with the computer. Please note for rated
games if you want an accurate chess rating we suggest you do not use this option.

Offer draw
This menu item allows you to offer a draw to the computer. The computer will
consider your draw offer and either agree to the draw or refuse it and choose to play
on.

Resign
This menu item allows you to resign the game. Your opponent will be awarded the
win.

Pause
This menu item allows you to pause the current game, the clocks will be paused. You
can resume the game by selecting this menu item in paused game condition and the
clocks will restart. Very useful if you need a break during the game.

Move now
This menu item forces the computer to stop thinking and make its move. It only has
an effect if the computer is thinking.

Hint
This menu item requests a hint move from the computer. The hint move with be
animated on the board so you can see what move the computer is suggesting.

Coach
This menu item allows you to toggle the coach on or off. When on the coach will
warn you if it thinks your move might be a serious mistake and the coach can even
alert you to the possibility that you may of missed a very strong move.

View rated users...
This menu item will open the Rated users dialog where you can view the current
chess ratings of players who have played games in HIARCS Chess Explorer.

Database menu
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Quick search
This menu item will open a Quick search field in the Game Explorer view so you can
enter a quick search string.

Search header
This menu item will open a Header search dialog so you can search the current
database for games based on header settings.

Find position
This menu item will open the Find position dialog so you can search for games
containing a position, material or pawn structure.

Reset filter
This menu item will reset the filter to cover the entire database

Reverse filter
This menu item will reverse the filter so the filter become every game from the
database which is not in the current filter

Show statistics
This menu item will open the Filter statistics dialog so you can check them and
perhaps use the White/Black filtering.

Toggle current game
This menu item will toggle the tick selection of the current game, if it is ticked in
the game list it becomes unticked, if it was unticked it becomes ticked.

Select all games
This menu item will select all the games in the Game Explorer game list (all will be
ticked). Please note if all are already tick selected this will unselect all the games.
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Clear selection
This menu item will clear the tick selection of the current game.

Mark for deletion/Restore selected games
This menu item will mark for deletion all the selected games, if the selected games
are already marked for deletion this will restore those games.

Manage...
This menu item will open the Manage database dialog where you can manage the
current database.

Help menu
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HIARCS Chess Explorer Pro Help
This menu item launches your default browser to open our online html manual for
HIARCS Chess Explorer Pro.

Help videos
This menu item launches your default browser to open our online videos for HIARCS
Chess Explorer Pro.

Check for updates
This menu item launches your default browser to check if there are updates to the
current HIARCS Chess Explorer Pro you have. You can also check the current version
installed from the About HIARCS Chess Explorer Pro dialog.

About HIARCS Chess Explorer Pro
This menu opens the About HIARCS Chess Explorer Pro dialog where you can check
the version you have and update to a higher spec HCE-Pro version.

Move context menu

Move context menu

You can right click on any move in the Game Notation to bring up the move context
menu as below:

Insert >

This submenu item allows you to insert into the game notation in a number of
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ways using the nested menu items:

o Comment...  - this allows you to insert a text comment at the current move
in the game notation. It will bring up an Edit comment dialog. You can also
add diagram in the Edit comment dialog.

o Preceding comment....  - this allows you to insert a text comment before the
current move of the game. It will bring up an Edit comment dialog.

o Best move - this option will insert the best move as suggested by the current
analysing engine (if one is running) and change the position to after that
move was played and the engine will begin analysing this new position.
Depending on the context of the move to the game notation the following
action is performed:
§ If the move is at the end of the current variation, the move is added to

the game notation.
§ If the move is new and different to that played in the game notation, a

new variation will be started in the game notation with the move
inserted.

§ If the move is the next move in the game notation no new move is
inserted but the position changes to that after the move was played.

§ Please note if you want to insert the whole line currently being analysed
by the current engine simply click on the score/depth text value and
the whole line will be added as a variation with the evaluation and
depth. In this case the engine will continue to analyse the current
position.

o Null move - this menu item makes a null move in the current position. A null
move is basically making no move therefore giving up the right to move, the
opposite side will then be next to play. A null move is illegal in chess play but
is very useful in analysis, for example you may play a null move in a
variation to illustrate what would happen if the side to play does nothing,
thereby showing possible threats of the opponent. Please note a null move
can also be played on the chess board simply by moving the king of the side
to play onto the opponents king. Null move now has a keyboard short cut of
Ctrl+0.

Remove >

This submenu item allows you to remove from the game notation many different
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aspects using the submenu items:

Current symbol - this option removes the current symbol in game notation at
move cursor position
Current variation - this option allows you to remove the current variation shown
in the game notation. It has no effect on the main line of the game, it only
affects variations.
    Remove current variation - this will delete the current variation, for example::

       

       choosing remove variation on the 6...e5 variation will remove it:

       

Current highlight - this option removes the current highlight at the move cursor
position
Last move - remove the last move at the current move cursor position
All previous moves - remove all previous moves from current move cursor
position
    this will remove all the previous moves, for example:

       

       choosing remove variation on the move 2...d6 will remove the previous
moves:

      

All next moves - remove all the next moves from the current move cursor
position
    this will remove the following moves/variations:

       

       choosing remove next on the move 7.f3 will remove the move following it:

       

All variations - this option will remove all variations from the game notation
All comments - this option will remove all the comments from the game notation
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All symbols - this option will remove all move and evaluation symbols from the
game notation
Everything except main line - this option will remove all comments, variations
and symbols from the game leaving just the main line of the game

Variations > 
Allows you to manipulate variations in the game notation:

Promote the current variation
Promote  - this is used to promote a variation up one level closer to becoming
the main line of the game. When promoting a variation you are in effect
demoting any variation it replaces. Please see this example:

A main-line and variation:

Promoting the 6...e5 variation has this effect, 6...e5 line is promoted, 6...e6 line
is demoted:

    

Promote to main line - this is used to make a variation become the primary
variation, that is the top variation. When you choose Make primary variation on a
variation like 6...Ng4 in the example below:

       

       It produces makes the 6...Ng4 variation the top variation as follows:

       

Move up - this enable you to move a variation up one level in the notation
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Move down - this enable you to move a variation down one level in the notation
Reorder... - this enables you to reorder the variations in the Reorder variations
dialog:

Set move symbol >
Set the move symbol at the current move cursor position

Set evaluation symbol >
Set the evaluation symbol at the current move cursor position

Add other symbol >
Add other symbols at the current move cursor position
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Toggle Diagram
Add or remove (toggle) a diagram at the current move cursor position in the
game notation.

Dialogs
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New database dialog
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In the New database dialog you can choose between a HCE and PGN database format
and choose the location and name of your new database. After clicking Save the
database will be created and shown in a new database tab of HIARCS Chess Explorer
Pro.
Here you can see there is a Databases folder already created in your
Documents/HIARCS Chess/Databases folder.

Databases dialog
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The Databases dialog shows the databases you have previously opened. You can use
the column headers to sort the databases displayed into different orders. Databases
which are already open in a database tab of HIARCS Chess Explorer Pro are shown
greyed. To open a database from the list simply double click the database or click a
database and click the Open button. Databases are opened into a new database tab
of HCE Pro. 

If the database you want to open is not displayed in the dialog you can click the Open
another database... button which will open a system dialog so you can choose the
database from your computer file system. HCE Pro can open HCE, PGN, CBH, CBV,
EPD database formats.

To the right of each database name you can choose some special operations on it.
Move the mouse to the right of the database name and you will see ... in a circle, 

click the ... and you will get a menu of operations



HIARCS Chess Explorer Pro

61 / 128

This enables you to:
· Convert a PGN database to native format
· Open the folder containing the database in a Explorer or Finder window
· Copy database opens a system dialog and enable you to copy the complete

database to another database file name in the same format.
· Rename the database
· Forget the database - that is remove it from the list of Databases

Open URL dialog
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Enter the http or https address of the PGN database you want to download. The PGN
will be opened in a live game database tab.

These PGNs are often live PGNs, that is they are actively being changed with new
moves or games being played. HIARCS Chess Explorer Pro will update live PGNs
regularly.

Import database dailog
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This dialog allows you to import a database of various formats into the current
database tab. Please note when you import games they will be added to your existing
current database which is open. This operation cannot be easily undone so please use
caution when importing games into your important databases.

Export database dialog
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This dialog allows you to export the current game, filter or database to another
database or other format.

For example:

You can choose the format you want to export to:
· PGN database - best for sharing small databases with other people as PGN is a

standard chess game format
· HCE database - best for other HCE Pro users and for large databases as HCE is the

fastest format
· HTML document - if you want to publish your games or preparation
· PDF document - if you want to share your games and preparation

You can choose to export to:
· the current game in the notation to a new database
· all the games from the current filter (if set) to a new database
· the entire current database to a new database

Setup position dialog
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Accessed by clicking the set up position  shortcut icon.The dialog is also

accessed from the Edit->Set up position menu item. The Setup Position dialog allows
you to edit an existing position or set up a new position altogether.

The dialog shows the following information:

· The current board position of the edit
· The current side to move in the position
· The move number of the position
· The current FEN of the position at the bottom of the dialog
· On the right hand side there is a palette of chess pieces to select from

Changing the position

You can change the position in a number of ways:
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· You can drag any piece to another square to move it
· You can drag any piece off the board to remove it
· You can select any piece/colour from the palette:

o then click on one or more squares to add the piece on that square
o if you click on a square which already contains that piece/colour it will be

removed from the square leaving it empty

Operation selections

Use the Select position selector to

· Select Empty board will clear the board of pieces leaving an empty board
· Select Starting position to reset the position to the opening chess position
· Select Current game to reset the position to the position in the current game

shown in the current database tab

Use shortcut keys to:

· Ctrl+V (Cmd+V on macOS) to Paste FEN position from the clipboard onto the board
· Ctrl+V (Cmd+V on macOS) to Copy FEN from the current board position shown onto

the clipboard
· Cancel will cancel the position set up and return to the game window
· OK will accept the position set up and return to the game window with the new

position

Advanced tab

In the advanced tab you can adjust:

· the Castling rights of the current position shown in the Board tab - please note in
any position HIARCS Chess Explorer will initially set the most likely castling rights
for the position.

· set the number of plies (half moves) since the last capture or pawn move.

Preferences dialog
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Accessed by clicking the preferences shortcut icon. The dialog is also accessed

from the Edit->Preferences menu item.

This dialog can be used to configure the preferences for HIARCS Chess Explorer Pro.
The preferences fit into Five broad categories each covered by a tab view:

· Board configuration tab allows configuration of the chess board and chess set
presentation, and move highlights

· Notation configuration tab allows configuration of the game notation fonts and
colours

· Moves configuration tab allows configuration of making moves, replay and
evaluation

· Engines configuration tab allows configuration of the chess engines used and
common data they use

· Advanced configuration tab allows configuration of the advanced settings and
language settings

When the preferences are configured the settings remain set each time you run the
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program until you next change them.

Clicking the Apply button will apply the current settings but keeps the dialog open.
Clicking the Cancel button will cancel any changes since the last apply and exit the
dialog. Finally click the OK button to apply the current settings and exit the dialog
back to the main display.

Preferences Board tab

The Board tab of the Preferences dialog enables you to configure the board, chess set
and highlighting aspects of HIARCS Chess Explorer Pro.

You can set the chess set you like from the Alpha, Fun, Hiarcs, Leipzig, Merida,
Modern, Russian and USCF chess sets. Each chess set can be presented as Plain, with
an Outline or with an Outline and Shadow.

The actual chess board can be set to multiple different textures including wood,
marble, stone, slate and solid colours. You can see below some of the piece and
texture combinations:

https://www.hiarcs.com/hce-manual/pc/Preferences.html
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TBD

Any changes you make to the Chess set or Board style will be reflected in the sample
chess board in the Board tab. This enables you to see what the combination of boards
and chess sets look like before you decide on your preference.

You can also change the highlight colours for the highlighted squares by clicking on
the highlighted squares you will get a colour palette to set your preferred colour.
Similarly you can also configure the colour of the Frame, Engine move, Book move,
Good move and Bad move highlights.

You can also adjust the presentation of coordinates around the board using Show
coordinates. This setting will also show coordinates in printed diagrams.

A frame around each square on the board can also be set on if you prefer it. Finally
the last engine move can be highlighted although we have left this off by default as
the move animation given by HIARCS Chess Explorer highlights the last move of an
engine well in play mode.

Clicking the Apply button will apply the current settings but keeps the dialog open.
Clicking the Cancel button will cancel any changes since the last apply and exit the
dialog. Finally click the OK button to apply the current settings and exit the dialog
back to the main display.
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Preferences Notation tab

This dialog tab allows you to set the fonts for the game notation and the colours
used.
You can also change the format to a column format for the main line rather like a
score sheet.
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Preferences Moves tab

This dialog enables you to configure how Moves are handled

Autocomplete moves enable you to choose whether HCE Pro helps you by auto
completing move when clicking and releasing the mouse on a piece or square on the
chess board the best move of that piece or to that square is played automatically:

Show move quality when dragging allows you to see the move quality of when you
click and hold on a piece:

Variation popup enable you to choose if and how you want to see variation when
using the keyboard arrow shortcuts when stepping through a game:
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Sounds:

Replay allows the configuration of the replay and animations.

The Evaluation settings enable you to decide on the thresholds you want in the game
analysis. We recommend you do not change these unless you are sure about the value
you wan to use.

Preferences Engines tab

The Engines tab of the Preferences dialog handles  adding, configuring and removal
of chess engines.

As part of the HIARCS Chess Explorer Pro package you will have the HIARCS 15.0
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engine, Deep and Premium customers have the Deep HIARCS 15.0 engine available
automatically installed and added. If you are an existing HIARCS Chess Explorer
customer you will also have the HIARCS 14 engines installed if you are licensed. You
can also add any other UCI compatible engine.

You can perform a number of operations on engines by right click the engine you get
this pop up menu:

These allow you to:

· Configure the engine settings - each engine has different settings

· Rename the engine - you can add some text to indicate particular settings

· Copy the engine - you can make multiple copies of the same engine with different
settings

· Change the executable assigned to the engine name

· Open the folder containing the engine executable

At the bottom of the dialog are the common settings applied to each engine for:

· Hash table size - this is a search table chess engines use to cache positions. The
value is set in Megabytes (MB), for general use 256Mb is a good size to use. In
general do not use more than 50% of the physical RAM on your machine. The
up/down arrows allow the adjustment of the Hash table size in values which are
powers of 2 or half steps thereof (e.g. 64Mb, 96Mb, 128Mb, 192Mb, 256Mb).
Alternatively, you can click on the value to enter an exact Hash table size.

· Endgame hash size - this is the size of an endgame cache of Nalimov tablebase
positions. If you have all 3, 4, 5 & 6 piece tablebases then use 512MB or more. For
5 piece tablebases you can use less, e.g.128MB. For just 4 piece tablebases 32MB is
enough. The up/down arrows allow the adjustment of the Nalimov cache size in
values which are powers of 2 or half steps thereof (e.g. 32Mb, 48Mb, 64Mb,
96Mb,128Mb). Alternatively, you can click on the value to enter an exact Nalimov
cache size.

· Autostart analysis gives you the option to decide how chess engines will behaviour
when you choose the View->Analysis Explorer.. view:
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For Nalimov and Syzygy tablebase paths you can be set by clicking on the ... buttons
when you will be given a Select folders dialog:
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Preferences Advanced tab

The Advanced tab of the Preferences dialog handles miscellaneous configuration
settings in the following areas:

Application Language allows you to set the language you want. By default this is set
to your OS default.

Databases
If the Overwrite existing ECO codes checkbox is set the following actions apply:

· when a database is loaded into HIARCS Chess Explorer Pro the openings are
automatically classified for their ECO opening code overwriting any ECO code
already set.

· any games added will have the ECO code classified by HIARCS Chess Explorer Pro
and the ECO field will be read-only.

When Overwrite existing ECO codes checkbox is unset the following actions apply:

· when a database is loaded into HIARCS Chess Explorer the ECO only classified if it



HIARCS Chess Explorer Pro

76 / 128

is not present, any existing ECO value in the database is never modified
· when you save a game HIARCS Chess Explorer will populate the ECO field if it is

empty. You can always edit the ECO field.

If you prefer to keep the original ECO code assignment already in databases please
uncheck this option.

Online sources
Use Hiarcs server to retrieve opening and endgame information - by default HIARCS
Chess Explorer will contact the HIARCS Chess Server (HCS) to retrieve information
about openings and endgames which are displayed by Book  Explorer and Analysis
Explorer as appropriate. If you want stop access to the HIARCS Chess Server this
option can be unchecked but you will lose out on much chess information and will
not be able to receive bonus chess information and tools in the future.

The Book license field allows HIARCS Opening Book subscribers to access additional
content in the Book Explorer. A valid book license will enable access to powerful new
opening books on the HIARCS Chess Server. For security reasons actual licenses are
never displayed and are always encrypted. Book subscriptions are a separate
purchase that can give access to the largest and strongest chess opening books,
please see www.hiarcs.com for details.

Clipboard Diagram size and coordinates can also be set here.

Clicking the Apply button will apply the current settings but keeps the dialog open.
Clicking the Cancel button will cancel any changes since the last apply and exit the
dialog. Finally click the OK button to apply the current settings and exit the dialog
back to the main display.

Edit comment dialog

https://www.hiarcs.com
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This dialog allows you to add comments and diagrams.

Configure engine settings dialog
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The Configure current settings dialog enables you to view and change the settings of
an engine. Each different engine normally has different settings.

Select moves to analyse dialog
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The Select moves to analyse dialog enables you to select the moves an engine will
analyse, this allows you to limit the move selection choice of the engine to moves
you are interested in.

CTG books dialog
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The CTG books dialog enables you to add CTG books to be used in HIARCS Chess
Explorer Pro. 

The + button is for adding CTG books, the - button is for removing the current
highlighted book.

Click the + to add a CTG book...

In the system dialog locate the CTG book on your hard disk and click OK.

The CTG book added will be shown in the CTG books dialog and can now be selected
in the Book Explorer view.
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Book information dialog
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The Book information dialog gives you statistics about the currently open book in the
Book Explorer view.

Above the book information is about an online book in the book subscription.

Another example of book information of a CTG book:

Browse tree games dialog
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The Browse tree games dialog allows you to browse the games from the Tree Explorer
view.

You can select any game from the Tree game list, play through them or Load them
into the database view  or more usefully Insert into the current game notation using
the Inset into current game button. This will be useful if you are annotating a game
and want to cite similar or important other games.

In addition to these capabilities you have a number of options you can apply to the
Tree game list from the icon set above the game list:

 Filter by rating - you can have the list of games reduced to the top games
played with this position:

 Filter by result - you can have the list of games reduced based on the result
of games:
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Filter by data - you can have the list of games reduced by how recent they
are:

Reset filter - to show all games in Tree Explorer filter set

 Show filter statistics - shows the Filter statistics dialog for the Tree filter of
games.

Filter statistics dialog
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The Filter statistics allow you to view the statistics for the games shown in the Game
Explorer game list or the Tree Explorer game list. These may reflect the entire
database or the Filter if that is set.

As well as the overview of the quality and quantity of the database in the Filter it
gives useful short cuts to data on White and Black.

For example in the MasterBase we want to search for ideas in the Sicilian Dragon, so
a Quick search of B70-79 (the ECO range to catch Sicilian Dragon games). The filter is
now set to 2016 / 347,333 games.
Now click the Show filter statistics in the Game Explorer and we get:
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This shows White has a 57.94% advantage in the Dragon lines, now click the White
tab:
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We can now see the players who have played the White side in most games. Now
click the Black tab:
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We can now see one GM in particular has played many more Dragon games than the
other players. Since this is clearly a speciality of this player it would be interesting
to view his games. Now double click Jones, G (or click the player and click Show
player games). The filter is now set to those 58 games.

We can go further open the Tree Explorer and click the toggle between database and
filter and we can then see a Tree of games played by this Dragon specialist and the
moves and stats of their played repertoire.

Analyse games dialog
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The Analyse games dialog enables you to analyse one or more games using settings
for the analysis.

Engine and time:
· Engine: You can select the engine to analyse with and configure its settings
· Mode: Select the mode of analysis:

o Blunder check is a quick check for blunders in the game(s)
o Average time per move to use for the analysis
o Average time per game to use for the analysis
o Fixed search depth to use for each move of the analysis

Analysis scope:
· Games: You can select the current game for analysis or bulk analyse all the games

in the filter (or database if not filter is set). Please note analysing a bulk number
of games may be time consuming.

· Colour: You can choose to analyse White, Black or both sides. In general analysing
both sides of a game does reveal more detail of that happen in the game.

· Moves: Either analyse all the moves in the game(s) or a move range
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Finally you can have any previous analysis removed.

Header search dialog
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Accessed by clicking the Header search  shortcut icon.The dialog is also

accessed from the Database->Search header menu item. This dialog allows you to
search the current database for games matching the search criteria, the search
results are known as the as the search filter.

You can specify any of the fields in the dialog to search for, or leave them blank to
indicate match all for that field. You can use the Ignore colours checkbox to indicate
that the White and Black fields can also apply to Black and White thereby matching
both colours.

As you type a name in the White, Black, Event or Site field HIARCS Chess Explorer 
Pro will aid your selection by giving you possible values based on what you type, this
is a great help in remembering difficult names or events etc.

Incomplete fields are treated as the first part of a wildcard, for example type "Ka" in
the White field will find all players with a name beginning with "Ka" like Karpov,
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Kasparov etc. Here is an example from the TopGames database when typing "An" in
the White field, you will see only the possible names match "An" are offered making
it much easier to name players correctly.

You can choose dates down to precise days and ranges.

You can also search for openings based on the ECO code.

The results and length of games are also searchable as are the information contained
in the games like variations, comments and even who annotated the game.

The Search mode: allows you to:

· Search all the games in the database, this is the default mode of operation

· Search the current filter

· Add the search of the database to the current filter

Edit header dialog
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The Edit header dialog allows you to edit the game header for the current game.

Edit common tags dialog
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The Edit common tags dialog allow you to set the common tags among a set of games
and change the values for all those games .

Play game dialog
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The Play game dialog allows you to set up a game to play against the computer.

Accessed by clicking the Play game  shortcut icon.The dialog is also accessed

from the Play->New game... menu item. This dialog enables you to configure the
type of game you wish to play against the computer.

There are many sections to the Play game dialog as follows:

Player:
This section allows you to enter the name of the player who will play the game (it
defaults to your name).

You can access Rated users statistics by clicking on the ... button next to your name,
this will display the Rated user dialog.

You can choose if you want the game to be a rated game. The player's current rating
is also displayed, here it is 1600 Elo.

Opponent:

This section allows you to select your opponent. Any engine loaded into HIARCS Chess
Explorer can selected, however not all engines support set Elo ratings like HIARCS
chess engines.  Also no other chess engine supports the play realism of the HIARCS
chess engines.

Engine: Select the engine and you can pre configure it using the engine settings icon

https://www.hiarcs.com/hce-manual/pc/Ratedusers.html
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to open a configure engine settings dialog.

Rating: You can select the rating of your opponent:

· Maximum setting allows the engine to play its strongest chess
· Match player strength allows you to play an adaptive opponent which matches

your estimate chess strength
· Custom allows you to set a specific Elo rating for the engine to play at. The up and

down arrow selector will increase or decrease the value in 25 Elo steps. You can of
course click on the value and set an exact value from the keyboard.

Book: You can select the book the engine will play from but please note only the
HIARCS Internal book can adapt to your Elo strength in the book moves it plays:

If you want your opponent to also think about its next move while it is your turn to
move you can turn this on or off using the Think on player's time checkbox.

Time control:
You can optionally choose a time control to play at. Here are the options:

· No time control selected - the opponent will move instantly, nice for casual play.
· Time per game - you can set the time which each side has to complete all their

moves
· Time per game with increment - the same as Time per game except in addition

you can set an increment in time each player gets for each move they make
· Time per given moves - this allows you to set the number of moves each side must

complete in a given amount of time
· Average time per move - this is a simple setting to get an average time per move

you want

In addition to these time control settings you can also set extra time on the human
players clock at the start of the game.
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Position and colour:

Colour: Choose to play White, Black or let HCE-Pro decide with a random choice:

Starting Position: This option  allows you to set the starting position for the game, for
example you can set the standard starting position or a position from a well known
opening which is very useful for practice and learning.

Standard: The normal chess starting position 
Current: The current position in the tab you start Play->New game... from (useful for
practising play from a particular position)
Opening: You can select from a wide range of openings:

Chess960: You can play a Chess960 game using either a Random or any of the 960
starting positions.

Engine match dialog
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The Engine match dialog allows you to set up a match between two engines.

Engine match Basic tab

Engines:
You can set the engines to play White and Black and configure their settings.

You can select the book each engine will use:

You can set an Elo limit for each engine if you want but of course that will weaken
the play.

Time Control:
Select the time control to use:
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Games:
Starting position: You select the starting position for the games:

· Standard is the standard opening position
· Current is the current position shown in the tab you launch New engine match

from
· Subsequent from chosen database will take the end position from a test database

and play using these in sequence 
· Random from database will take a random position from the chosen database for

each game

Database:
Choose database to use as starting positions for the match (only applicable to last
two options above).

Rounds:
Set the number of ronds to play in the match and if you want to reverse colours after
each game.

Engine match Advanced tab
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Memory:
Choose the hash table for each engine to use and the Nalimov cache size

Match details:
Choose the type of information to save with each move:

Enable adjudication for HCE-Pro to decide when each game result if determined - this
saves time in drawn games and when it is clear one side is going to win.

Event:
Set the title of the match

Find position dialog
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The Find position dialog enables you to find games containing a chess position or
material, pawn structure or both material and a pawn structure.

Set the scope of the search using the Search games: selector:

· Search all games in the database
· Search games in the current filter
· Search games not in the current filter

Choose to ignore colours or only find with a colour match to the set up pieces.

Find games with a position
Set the position you want to find. The default position will be the one you last used. 
You can also get the position from the Current game, choose the starting position or
empty board and set up a position to search for.
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Find games with a material
Please note the material must be present for one full move (2 ply) for the position to
match.
You can set the material on the board and choose what colour squared bishops you
want:

This will find games with BvN with R4P v R3P. Pawns can be on any files.

Find games with material and pawn structure
Please note the material or pawn structure must be present for one full move (2 ply)
for the position to match.

You can set the material on the board and choose what colour squared bishop and
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pawn structure you want:

This will find games with BvN with R4P v R3P. Pawns must be on these squares.

Find games with pawn structure
You can set the pawn structure you want to find on the board:
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This will find all games with the pawns on these squares.

You can click the pawns to make them fuzzy meaning they just have to match a
placements on the same file:
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Manage database dialog
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The Manage database dialog enabled you to manage your databases. Each database
has a manage database dialog.

Clean up tab
Above you can see the Cleanup tab, this is where you can permanently remove
games marked for deletion using the Remove marked games button. Alternatively
you can Restore any games marked for deletion using the Restore button.

Statistics tab
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You can see important stats about your database and open Windows Explorer (or
Finder on Mac OS) by clicking the path: field

Duplicates tab

This tab enables you for find duplicate games in the database and review them in the
Duplicate game comparison view.
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Flip board tab

Here you can choose players where you always want the board to be flipped so you
can see the game from the player's perspective. For example with Carlsen set here
any game loaded played by Magnus Carlsen will be shown from his perspective, if
Carlsen is Black the board will be shown with black at the bottom moving up. 

Extra tags tab
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Extra tags in a database can be selected and removed using the Extra tags: option
with the Remove selected tags button.

Rated users dialog
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This Rated users dialog is accessed from the Play->View rated users... menu item.

It shows the current users who have ratings, the number of games played and the
results so far achieved.

Please see our Elo Ratings section for an explanation of ratings.

About HIARCS Chess Explorer Pro
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The About HIARCS Chess Explorer dialog shows the current version you have
installed.

You can deactivate your license from this dialog if you want to sell or give your
machine away. In fact if you are no longer going to use HCE-PRO on your machine we
strongly recommend you deactivate the license so you can use it on another machine
without issue.

You can also update your license to more advanced versions of HIARCS Chess Explorer
Pro. There are three versions available:
1. non Deep standard version which has the single core HIARCS 15.0 engine and other

limitations
2. Deep version which has the Deep HIARCS 15.0 chess engine and other benefits
3. Premium version which has Deep HIARCS 15.0 and experimental HIARCS chess

engines for a year and other benefits like huge online books and endgame data.

The Other resources tab shows you the credits and acknowledgements.

Explorer Views

Game Notation

Game Notation
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The Game Notation pane displays the game header information, moves, comments,
variations and symbols for the current game.

Game Header Information

At the top of the game notation we have:

· White and Black player names and Elo ratings (if available) and the game result.
Please note the players names in blue are hyper-linked so you can simply click the
player to open the Player Explorer to view the games, performances and favourite
openings of the player in the Information tab.

· The event and site where the game was played and the round and date on which
the game was played

· The ECO code and opening name

Game Notation

Below the game header information the actual game is displayed. The game notation
can have the following information:

· The main line of the game (e.g. the moves played in the game) is shown in bold
text

· Move variations (these can be nested) are shown in blue
· Comments are shown in green as are diagram designations (see move 13.dxe5)
· Move, evaluation and other symbols are shown in red (see respectively 14. Bh3!?

10. Qc8=, 12.Rac1N etc)
· The current move is highlighted (see 13.dxe5) and the position after the

highlighted move is displayed on the Game Board.
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Navigating the game notation

There are many way to navigate the game in the game notation:

· Use the mouse left click to go directly to any move or variation, the position will
then be shown on the Game Board.

· You can navigate to the beginning of the game, previous move, next move or end
of game by using the move navigation icons:

      
· The play navigation icon above gives the ability to start replaying the game moves

from the current position. The pause icon pauses the replay.
· The keyboard can be used to navigate the game, if you use the left or right arrow

keys they will move backwards or forwards through the current line of play. The
arrow key navigation will not present annoying variation dialogs or enter sub-
variations.

· To be offered the move variation choices at each move use the Cmd+right arrow.
If there is choice of moves at any point in the game notation you will be given a
Select move dialog so you can choose the continuation.

· The Cmd+left arrow will jump back to the previous higher variation which is just
before the point this variation branch was entered.

· The down arrow jumps forward 5 moves on the current line, while up arrow will
jump back 5 moves on the current line.

Undo/Redo

You can perform unlimited undo and redo operations performed in the Game
Notation on the current game since it was loaded. 

Move context menu

You can right click on any move to bring up the move context menu 

which enables you to insert, remove comments, moves and set diagrams, move
symbols, evaluation and other symbols. Please note you edit comments by clicking on
them.
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Analysis Explorer

The Analysis Explorer view displays the output of the chosen chess engine. Here we
see the best 2 lines of analysis for the current position being displayed. Please note
the height of the view is automatically changed to accommodate the display of the
number of lines.

The output consists of the evaluation (+1.00 = 1 pawn positional advantage) and the
current depth of analysis followed by the best line of play expected by the engine.
You can click the eval/depth and the analysis for that line will be added to the Game
Notation. If you click on a move in one of the lines shown the eval and line up to
that move will be added to the game notation.
If you pass the mouse over a move of one of the lines displayed a pop up board will
appear with the position at that point in the line, you can then use the arrow keys to
follow the line:

Configuration options
There are many configuration settings available in the Analysis Explorer view, you
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will notice some icons in the top right corner of the view:

From left to right these are:
· Configure current settings of the current engine

· You can check and modify the number of threads used by the engine (assuming the
engine support multiple threads):

· You can modify the number of lines of analysis the engine is producing:

· You can pause or resume the analysis, this is only possible with HIARCS 15 chess
engines. It may be useful to pause the engine if you wanted to use your CPU
resources elsewhere for a while but later want to resume the analysis.

· You can use the padlock to lock the analysis to a position, this means the engine
analysis will remain on the locked position while you can move around the game
notation and even use another engine in a different position in the same game.

After looking at a game if you want to return to the board position where the
analysis is locked, click on Go to the position

· You can select which moves the engine analyses using the Select moves to analyse
dialog.

· You can select the type of output produced by the Analysis Explorer here:
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· Finally you can switch to another engine from the available chess engines:

Game Explorer

The Game Explorer enables you to explore and manipulate the games within a
database. You can see the database name and how many games the current view
shows out of the total database size.
It displays the games in the current filter of the database in the list below. Each
game can be selected to view or selected to perform an operation on:

You can tick games to put them in a selection and then you can then:
· Select all games in the game list - you can then perform operations on all the

games, for example copy
· Clear the selection - removes all ticked games
· Set filter to selection will set the current filter to the ticked games
· Remove selected game from the filter - this will remove all ticked games from

the current filter
· Mark current game for deletion - the current game is marked for deletion, the

game are greyed with a line through them but they are not deleted until you
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choose Clean up database in the Manage database dialog
· Mark 2 games for deletion - all the ticked games (in this case 2) will be marked

for deletion. The games are greyed with a line through them but they not deleted
until you delete from the Manage database dialog

· Copy 2 games to clipboard - all ticked games are copied to the clipboard, you
may want to paste them into a different database for example

· Edit common tags for selected games  - all the common non player tags are listed
in the Edit common tags dialog and you can edit them for all the games in the
ticked selection.

Game Explorer options
In the top right hand corner of the Game Explorer you will see some icons:

In left-right order these are:

 Manage database - opens the Manage database dialog for the current database

 Delete/Restore selected games - delete or restore the ticked selection

Show filter statistics - for the current game list (filter) in the Filter statistics

dialog

Reverse filter - reverse the current filter

Reset filter - this reset the current filter to all database games

Quick search - this opens the quick search field

Maximise/restore the Game Explorer game list size, when the game list is just at

the bottom of the window this icon will expand it to fill the whole window, in the

expanded state clicking this icon will restore the game list to its normal size.

 

Quick search

The Quick search field in the Game Explorer view allows you to create single and
range searches from the keyboard and combine searches to perform powerful
filtering of games. The Quick search filter is applied to all the games in the
database.

The quick search field stores you recent searches so you can select them from the
selector.
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Single searches

· Kasparov           find all games by Kasparov
· Kasparov-          find all white games by Kasparov
· -Kasparov          find all black games by Kasparov
· 2012.06             find all games from June 2012
· 2011                 find all games from 2011
· 1-0                   find all games won by white (note: use 1/2 or 1/2-1/2 for draw)
· B17                   find all games with ECO B17
· Site:London       find all games played in London (general form is Tag:Value)
· >2400                find all games with average Elo above 2400
· comment: - find annotated games
· comment:endgame - find games with word 'endgame' in the comments
· comment:"better endgame" - find games with phrase "better endgame"
· variations: find games with variations
· material:R3PvR2P
· material:KR3PvR2P

Range searches

· B10-B17              find all Caro-Kann games
· 2001-2011           find all games from 2001-2011

Combining searches:

· Kasparov- 0-1                     find all games lost by Kasparov with white
· Kasparov D80-D99               find all Kasparov games when Grünfeld was played
· Kasparov Karpov                find all Karpov-Kasparov games
· Kasparov- -Karpov              find all Karpov-Kasparov games where Kasparov was

white
· Kasparov-Karpov                find all Karpov-Kasparov games where Kasparov was

white
· Kasparov Site:London         find all games played by Kasparov in London
· Kasparov Karpov !1/2        find all games decisive games between Kasparov and

Karpov
· Zvj- Dre                           find all games with White starting "Zvj" and Black

starting "Dre", matches Zvjaginsev v Dreev
·
· OR <search>  - adds to current filter
· AND <search> - narrows current filter

Book Explorer

The Book Explorer view enables you to view opening books. Opening books contain the most popular
moves played in millions of positions along with the statistics for those moves and the play
recommendations.

In the top right corner of the Book Explorer view you can access a number of configurations:
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 Manage CTG books - this brings up the CTG books dialog where you can add CTG books so they can
be access in the Book Explorer view.

Book information - this allow you to see information about the book being displayed in the About book
dialog

Select book - this allows you to select a book from the available books which are listed in the book list:

Tree Explorer

The Tree Explorer view allows you to view the current or reference database or filter
as a tree of moves and statistics rather like an opening book.

The tree view will update to show the moves and stats for the current position in the
chosen database or filter.

Tree Explorer configuration
Using the icons in the top right corner you can configure the Tree Explorer to a
number of different views and even use different databases.

These icons are explained below:

 Toggle between filter and database tree - when this icon is shown the Tree is
displaying the moves and stats on the database. When this icon  is displayed the
Tree is displaying the moves and stats from the filter. Once the Tree Explorer is set
to the filter it will also show the context of the filter in the title:

Browse games - this opens the Browser tree games dialog where you can browse
the games in the Tree, this is useful to find the game relevant to your analysis and



HIARCS Chess Explorer Pro

120 / 128

even add other games to your current game notation.

 Set filter - this option sets the current filter to the games played where the
current position occurred.

Set database to display - this option allows you to set the database on which the
Tree is based. By default this is the current database but if you are working in on
some preparation you will want to choose a reference database, for example here
we have chosen the MasterBase database so the Tree shows the moves and stats from
games from top master players.

Evaluation Explorer

The Evaluation Explorer allows you to see the changing evaluations throughout a
game at the click of the mouse. With this chart you can see who had an advantage as
the game progressed.
Each bar represents a move in the game and included information about that move,
for example if you place the mouse pointer over a bar of interest, a tooltip will
appear showing the move and evaluation of that move.

 In the top right corner of the view you have a selector which allows you to
change the level of game analysis for the Evaluation view in Elo points. By default
this is set to 2400 Elo for fast production of the Evaluation chart, however you may
prefer to wait a few seconds and have much stronger analysis:
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Player Explorer

The Player Explorer dialog enables you to view a lot statistics about a database, it's
openings and the players and what they play. In fact you can get repertoire reports
on any chess player in the database.
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Database tab

First we are looking at the Database tab on the left, click that to view all the
openings and results played in the database with different opening systems.
Above you can see for many opening the statistics for those openings in the
database. This is where some power options exist:
· If you click any opening name, for example Queen's Gambit, the Player Explorer

will populate the Game Explorer game list with only Queen's Gambit games. 
· If you click any of the win/draw/loss graphic for a particular opening, the Player

Explorer will populate the game list with those games, for example you could look
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at Black wins in the Caro-Kann Defence by clicking on the black win bar of the
Caro-Kann Defence line.

· If you click any of the Games numbers, the filter of the Game Explorer will be set
to those games.

Please also note you can they set the Tree Explorer to the new filter of openings
which will give you for example a Tree of Benoni and Benko Gambit moves and stats,
extremely useful for those interested in chess theory from played games in certain
openings.

Players tab
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If you choose the Players tab on the top left, you will get a list of all the players in
the database, this list is searchable with hints and auto select completion. 
If you choose a player, for example Vishy Anand from the list you will get Player
Report on Vishy Anand which shows his performance with both White and Black and
the most popular chess openings he plays with the White and Black pieces. This is
shown in the Games tab.

Furthermore you can click on any opening, statistics or result from the win/draw/loss
graphic to get the Game Explorer game list and filter populated with just those
games.

This is a very powerful resource for preparation, you can choose a player you wish to
prepare for and have a Player Report generated of the performances in many
openings and you can view those games from many perspectives in one single mouse
click.

For example, here you can click the Black openings Ruy Lopez Berlin Defence and get
all the games Vishy Anand has played with the black pieces in the Berlin Defence
listed in the Game Explorer. Then simply open the Tree Explorer view and set the
Tree Explorer to the filter and you will have a Tree of Vishy Anand's Berlin Defence
play.

Player Rating Graph
You can also see a rating graphic for a selected player by selecting the Rating tab at
the bottom of the dialog when a Player is selected.
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Tournament table

You can get a tournament table on any set of games played in the same tournament
by choosing the Tournament table menu item from the View menu.

The tournament table gives you the tournament result in points and under different
tie break options. Furthermore you can have the current Game Explorer filter set to
the games from the tournament.
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Guess the move

You can choose Guess the move from the View menu. 

Use the Guess the move feature in our Tactics database to practice your tactics, you
will be challenged by many games where you have to find the correct tactical play
and you answers are scored.

There are some extra options in the Guess the move feature:

Skip a move, you can do this if you do not want to guess the current move
Change the colour you want to play
Restart the current game challenge
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Duplicate game view
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